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1.1 About EzPhone Recorder.
EzPhone Recorder is Windows-based phone call recording software that uses a phone recording
adapter or voice modem to record both incoming and outgoing phone calls. The program captures
caller id, monitors your telephone line, and automatically records phone conversations if a voice or
dialed phone number is detected. The built-in address book enables you to selectively record your
phone calls from your business partners, tax officers, customers, spouse, children, or friends.
Moreover, it instantly notifies you of newly recorded messages through emails to your mobile phones.
You can further attach memos or notes to all logged calls. Using its built-in search tool, you can
quickly retrieve and find these messages.

Along with the compatible phone recording adapter or voice modem, EzPhone Recorder can record
calls from a variety of devices such as telephone landlines (including VoIP lines), phone handsets, or
mobile/cellular phones. The software provides many useful features, including one-click manual
recording, unlimited recording length, and legal announcement if required by your country or state. Its
super-monitoring mode hides all screens from your desktop when auto-recording phone calls. Free
trial now for 15-days to find out more. The EzPhone Recorder product comparison is summarized
below.

 

EzPhone
Recorder
                    

EzPhone
Recorder
Professional

EzPhone
Recorder
Business

Price
US$ 49.95 
(MSRP US
$59.95)

US$ 99.95
(MSRP US
$119.95)

US$
159.95
(MSRP
US$189.95)

Maximum lines supported 1 3 5

Record both incoming and outgoing
calls Yes Yes Yes

Support both manual and auto-
recording modes Yes Yes Yes

Built-in address book to selectively
record calls automatically Yes Yes Yes

Capture and display caller id Yes Yes Yes

Auto-monitor phone line activities
for outgoing calls Yes Yes Yes

Voice-activated recording when
monitoring outgoing calls Yes Yes Yes

Super-monitoring mode for
outgoing calls Yes Yes Yes

Organize recorded messages under
different folders Yes Yes Yes

Notifying and forwarding recorded
messages to email accounts (e.g.,
mobile phones)

Yes Yes Yes

Legal announcement before Yes Yes Yes



recording if configured

Unlimited recording length Yes Yes Yes

Attach notes or memos to logged
calls and address book entries Yes Yes Yes

Sort logged calls based on time,
name, or phone number Yes Yes Yes

Powerful built-in search tool Yes Yes Yes

Compatible with other answering
machine software such as EzVoice Yes Yes Yes

Simple installation and quick setup Yes Yes Yes

 

EzPhone Recorder has been designed to utilize the modern computer multi-core architecture and is
highly reliable and easily configurable. Its algorithm has incorporated the latest advances in digital
signal processing. Hence, you can rest assured that all your selected phone calls are auto-recorded.
EzPhone Recorder is trialware, and you can free try this fully functional software for 15 days.

The minimal system requirements are as follows:

Windows 10/7/8.1/8, Windows Vista, XP.
Microsoft Internet Explorer 7.0 or above.
1.5 GHz CPU and 1G RAM.
10G disk space.
Microphone and speaker.
Phone Recording Adapter or Voice Modem.
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1.2 How to purchase this product and obtain a license key.
EzPhone Recorder comes with a 15-day free trial. Before you purchase, it is highly recommended to
use the application thoroughly to ensure that it fully meets your requirements.

To purchase or register EzPhone Recorder, please first log on to the internet and click the Purchase
button on your EzPhone Recorder toolbar to bring up the Registration window shown below. Next,
click the order link on the Register window; it takes you to the registration form in your web
browser. You can then follow the instructions on the web form to make your purchase. It is just a one-
time-only payment.

 

Upon completion of your transaction, you can request your license key by submitting the user id to the
following form. You can find the auto-generated user id on the top-left corner of the Registration
window, as shown above. Once the license key request is submitted, your key will be automatically
generated and emailed to you within a few minutes. However, if you do not receive it within an hour,

https://ezvoice.sunshinesoftsolutions.com/


please check your spam filter settings for your email account. More importantly, please ensure that our
domain (sunshinesoftsolutions.com) is not blocked.

Request EzPhone Recorder License Key. (free for paid users only)

Upon receiving the key, please click the Purchase button on your EzPhone Recorder toolbar and
enter the key into the license key field on the Registration window. EzPhone Recorder now runs on
your computer permanently.
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1.3 Recommend EzPhone Recorder to your friends.
There would be no EzPhone Recorder without the support from you, the EzPhone Recorder user. It is
you who have made this software better and better. It is you whose suggestions and support
encourage us to develop more and high-quality software applications. Therefore, if you love this
product and would like to recommend it to your friends, please click the Tell a Friend about
EzPhone Recorder button on the top of the folder tree. A drafted email is already prepared for you
in your email client. You can enter your friends' email and click the send button.

Your referrals and recommendations are much appreciated. Thank you.
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2.1 How does EzPhone Recorder work?
2.2 What are the hardware requirements and connections?
To let EzPhone Recorder record your phone calls, you need either one of the following devices.

A telephone recording adapter.
A voice modem, a regular dial-up modem supporting voice.

A phone recording adapter usually comes with two ends. One end is connected to your phone line or
phone handset, and the other end is plugged to either the microphone jack or USB port on your
computer. To use a voice modem, you need to purchase a regular dial-up modem that supports voice.
You should first install the modem on your computer, run its driver setup software, and then connect
the phone line from your wall to the modem jack marked Line. The following diagram shows three
common scenarios:

Scenario 1: Phone call recording adapter connected to the phone handset and the audio jack on
the computer sound card.
Scenario 2: Voice modem connected to the phone line or phone line splitter, and the computer
USB port.
Scenario 3: Phone call recording adapter connected to the phone line or phone line splitter, and
the audio jack on computer sound card.

https://ezphonerecorder.sunshinesoftsolutions.com/register/reqkey.htm


 

Once all devices are connected, as shown in the diagram, and the drivers are installed, you can run
EzPhone Recorder on the computer. To record phone calls manually, you can click the Record button
on the EzPhone Recorder toolbar.

This program captures caller id, monitors your telephone line, and automatically records phone calls if
a voice or dialed phone number is detected. To set this up, please refer to Setup auto-recording
mode for outgoing calls.

To auto-record incoming calls selectively, for example, from your business partners but not those from
your relatives, you can add your contacts in EzPhone Recorder built-in address book. Upon receiving a
new call, the program looks up the caller id in the address book, and begin recording phone
conversations if it matches your contacts. Step-by-step instructions can be found at Setup auto-
recording mode for incoming calls.

To get notified of incoming and outgoing calls, EzPhone Recorder forwards all recorded messages and
logs to your email accounts on your mobile phones or other devices. This feature requires you to have
an always-on internet connection. To set it up, please refer to Setup email forwarding and
notification for each line.

Please read through the user manual to Set up EzPhone Recorder to record your phone calls. If you
encounter issues or have further questions, please check out the Frequently Ask Questions sections
of this manual for details.
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2.3 Run EzPhone Recorder to record your phone calls.
Thank you for choosing EzPhone Recorder as your telephone recording software. EzPhone Recorder
automatically detects your hardware devices and shows you a list of supported devices on your
computer. If you only record phone calls manually, you can select a preferred device from the
dropdown list on the Setup Phone Recording Devices dialog. Then, you can start using the phone
recording feature right away. Please be sure that you have connected all your hardware devices as
described in the section: How does EzPhone Recorder work?.



To enable many other call recording features, such as automatic call monitoring and recording, a legal
announcement before recording, setting the line devices and their parameters, or activating the super-
monitoring mode, please follow the step-by-step guide described in the Main Setups section.

To be notified of new calls, please refer to Setup email forwarding and notification.
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3.1 Setup recording lines and devices.
EzPhone Recorder automatically detects all recording devices, including phone recording adapters or
voice modems on your computer. To set up the recording lines, please click the Setup menu on
EzPhone Recorder menubar, and choose the Phone Recording Lines & Devices submenu item. The
Setup Phone Recording Devices & Lines dialog is shown below.

To configure a particular line, please pick a phone recording device from its dropdown list, and click
the OK button to save your selection. Please also ensure that the selected devices are physically
connected to the phone line, as illustrated in the section: How does EzPhone Recorder work?.

Back to top

3.2 Setup manual recording mode.
To manually record phone calls, please click the Record (Standard Edition) button, or the Line #1
to Line #5 (Professional/Business Edition) buttons on the EzPhone Recorder toolbar shown
below.

You can configure manual mode for either incoming or outgoing calls, or even both. For example, you
might set up auto-recording mode for all incoming calls, but manual mode for outgoing calls made by
yourself. To set up manual recording mode, click the Setup on EzPhone Recorder menu and choose
the Phone Recording Lines & Devices submenu item to bring up the dialog below.



Please click the Setup button beside the dropdown list to show the Setup Recording Mode dialog.
Then, select manual mode under the incoming or outgoing call section on the popup. Once configured,
please click the OK button to save all settings.
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3.3 Setup auto-recording mode for incoming calls.
To auto-record incoming calls, EzPhone Recorder first waits for humans to pick up the phone call and
then starts the call recording based on the following two modes.

Auto-record all incoming calls.
Auto-record only those callers selected in the address book.

Under the first mode, no special features on your telephone lines are required. EzPhone Recorder
records all incoming phone calls automatically. To take advantage of the second mode, and selectively
record incoming calls, you must subscribe to caller id service from your telephone company. Besides,
you must use one of the following call recording devices:

A recommended phone recording adapter.
A voice modem supports caller id in your country.

Once the above criterion is met, EzPhone Recorder captures caller id upon new incoming calls. It then
looks up this id in its built-in address book, and start recording only if the caller matches one of the
contact entries in the book.

To setup auto-recording mode for incoming calls, click the Setup on the EzPhone Recorder menu and
choose the Phone Recording Lines & Devices submenu item. Then, the Setup Phone Recording
Devices & Lines dialog is displayed. Click the Setup button beside the dropdown list for the
recording line to bring up the Setup Recording Mode window, as shown below.

Please select a recording mode under the Incoming Call section as shown in the above popup dialog,
and click the OK button to save all settings.
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3.4 Setup auto-recording mode for outgoing calls.



If a phone recording adapter is used to auto-record outgoing phone calls, EzPhone Recorder monitors
your telephone lines continuously. Whenever a voice or a dialed phone number is detected, the
program kicks off the call recording.

However, if a voice modem is used, the program has to pick up the telephone lines every few seconds
to detect the voice energy or dialed phone numbers. You can configure how frequent EzPhone
Recorder checks your phone lines as follows.

 

NOTE: If this check occurs too frequently, it might impact the incoming calls, and the caller might get
a busy tone very often. This limitation only applies to voice modems in this mode. Nevertheless, the
phone recording adapter does not have this limitation as it does not pick up or interfere with the
regular operation of the telephone lines.

To set up auto-recording mode for outgoing calls and configure its parameters, click the Setup on
EzPhone Recorder menu and choose the Phone Recording Lines & Devices submenu item. Then,
the Setup Phone Recording Devices & Lines dialog is displayed. Click the Setup button beside the
dropdown list for the recording line to bring up the Setup Recording Mode window, as shown above.
Select one of the auto-recording modes under the Outgoing Call (Monitoring Mode) section on the
window. Once complete, please click the OK button at the bottom of the window to save all settings.
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3.5 Configure call recording parameters.
EzPhone Recorder provides a standard set of parameters for recording both incoming and outgoing
phone calls. These parameters are categorized into two groups.

Volume and gain controls for the recording.
End of call recording.

EzPhone recorder has a built-in gain and volume control that automatically boost the volume for both
calling and called parties. It is optimized to handle most of the calling scenarios and telephone lines.
However, if the recorded messages are still not clear due to unique phone line features or specific
issues, you can disable it. To configure, you can apply the default sound settings (only for voice
modem) or set up a fixed value for the volume (only for phone recording adapter), as shown below.

To properly stop call recording and save disk space, the program supports the silence detection that
stops recording automatically if the silence is detected for a specified time. Based on our experiences,
we recommend you to set the silence time longer than 5 seconds. To effectively identify the silence,
another parameter called silence sensitivity is also provided. When the voice energy falls below this
threshold, the program treats the recording as silence.

NOTE: If you are using a phone recording adapter to record calls, please keep silence sensitivity value
in sync with the volume control button on your adapter. In other words, whenever you manually press
the volume increase button on the adapter, you also need to increase the silence detection threshold in
the software and vice versa. Also note, some phone recording adapters do not have the volume
control button, so the above may not be applicable.

To further limit the length of a recording, you can set a non-zero value in "Stop recording if more
than xx minutes." The program counts the time upon start and stops the recording when the time



limit you define is reached. Entering a zero value disables this function, and EzPhone Recorder records
conversations for unlimited length.

To configure call recording parameters, click the Setup menu on EzPhone Recorder menubar and
choose the Phone Recording Lines & Devices submenu item. The Setup Phone Recording
Devices & Lines dialog is displayed, click the Setup button beside the dropdown list for the recording
line to bring up the Setup Recording Mode window. You can now change recording volume and gains
under the Recording Mode section and the silence detection parameters under the End of
Recording section on the dialog window, as shown above. Once completed, click the OK button to
save all settings.

Back to top

3.6 Enable super-monitoring mode for EzPhone Recorder.
When automatically monitoring and recording incoming or outgoing phone calls, EzPhone Recorder
provides a super-monitoring mode that hides all application windows from the desktop. To bring back
the menus and main window, you must assign a hotkey that you use to return to the normal state.

To activate super monitoring mode and specify its hotkey, click the Setup menu on the program
menubar and choose the Personal Preferences submenu item. Then, the Setup Preferences dialog
window is popped up. You can find hotkey options under the Super Monitoring Mode section on the
dialog. Upon the hotkey is defined, please click the OK button on the window to save all settings.
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3.7 Select a recording and playback device for your legal announcement
and recorded messages.
To record your legal announcement or playback recorded messages, you need a microphone and
speaker. In most cases, EzPhone Recorder automatically detects these devices on your computer and
select the default ones set by the operating system. However, if you have multiple recording or
playback devices and all of them are good for the above purposes, you should choose one that you
prefer, as shown below.



To select a recording or playback device, click the Setup on the EzPhone Recorder menu and choose
the Legal Announcement submenu item. The Setup Sound Devices & Legal Announcement
window is popped up as above. The dialog contains dropdown lists for both recording and playback
sound devices on your computer. Select your preferred recording and playback devices from the
dropdown list and click the OK button on the window to save the settings.
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3.8 Setup your legal announcement.
There are many laws defined regarding the phone call recording. More importantly, these laws vary
depending on the state, province, and country where the call recording occurs. Therefore, it is your
responsibility to ensure that you comply with the laws when recording phone conversations.

EzPhone Recorder can play a legal announcement before recording phone calls so that both parties are
notified. You can also turn this feature off if the recording laws in your situation do not apply. The
program comes with a default legal announcement, yet you can customize it.

To record your legal announcement, you select the Setup menu on the program menubar and choose
the Legal Announcement submenu item. Then, the Setup Sound Devices & Legal
Announcement dialog is displayed below. On the dialog, you first select the recording or playback
devices, and next proceed to the Legal Announcement section. From there, you turn on the legal
announcement option and click the Record button to record your legal notice. Once finished, click the
Stop button to stop recording, and follow by the OK button to save all settings.



NOTE:

The legal announcement can not be played onto the telephone line if the phone recording adapter
is used because of its lack of sound playback capability.
To record your legal announcement, you need a microphone connected to your computer. To listen
to it, you need a speaker.
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3.9 Setup/Activate email forwarding and notification for each line.
If you have an always-on Internet connection such as fiber, cable, or DSL, EzPhone Recorder can
forward newly recorded messages to your email accounts. So you can be instantly notified on your
mobile phones. The program supports email forwarding and notification on a per-line basis. In other
words, each line can forward messages to a different batch of recipients.

To activate the email forwarding and notification for each line, you need to follow the steps below.

First, configure the email server and create the email recipients.
Next, you assign these email recipients to the individual lines' notification list.

For example, suppose you have created recipients: a@a.com and b@b.com, and assigned
a@a.com to line #1 and b@b.com to line #2. Line #1 now forwards recorded messages to a@a.com
while the calls recorded on line #2 are forwarded to b@b.com.

To configure your email server and create email recipients, please click the Setup menu on EzPhone
Recorder menubar and choose the Email Server & Recipients submenu item. The Setup Email
Server dialog is now displayed below. Please fill in the email server details on the dialog, and click the
Next button to proceed to the Setup Email Recipients dialog. After creating recipients, click the OK
button on the dialog to save all settings.

To assign email recipients to each line, click the Setup menu on EzPhone Recorder menubar and
choose the Phone Recording Lines & Devices submenu item. Then, the Setup Phone Recording
Devices & Lines dialog is displayed. Next, click the Setup button beside the dropdown list for the



recording line to bring up the Setup Recording Mode window. You can now activate email forwarding
for this line by clicking the Enable Email Forwarding checkbox under the Email Forwarding
section, as shown below.

 

Once email forwarding is enabled, please click the Setup Email Forwarding button beside the
checkbox on the above window, it now shows the Setup Email Forwarding dialog below. You can
now add recipients to the Forwarded Email Accounts by clicking << button or remove them by
clicking >> button on this popup dialog. Once you are done, please click the OK button to save all
your settings.

NOTE: Enabling the Attach Message option when email forwarding increases the size of the
notification messages. Hence, it may use up your email account size quotas.
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3.10 Use the built-in FAQs and troubleshooting to resolve common issues.
EzPhone Recorder comes with the built-in FAQs and the troubleshooting that provide suggestions,
recommendations, and solutions. In some instances, it can even automatically fix the well-known
issues related to the hardware devices such as a voice modem or phone recording adapter. If the
problems can be auto-fixed, the program detects and verifies your device settings, and then applies
the patches to resolve the issues.

To use the built-in FAQs and troubleshooting, please go to the Help menu on the program menubar,
and choose the FAQs & Troubleshooting submenu item. Alternatively, you can also click the FAQs
button on the program toolbar. Then, the Troubleshooting FAQs dialog window is displayed. You
can now read through each issue and its solutions, and apply auto-repairs if provided.
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4.1 Create your contacts in the address book.
4.2 Selectively record individual callers.
4.3 Get notified of selected callers.
EzPhone Recorder comes with a built-in address book, and you can add contacts to it. For each
contact, you can choose to turn on or off the auto-recording or notification mode and also specify
additional email forwarding recipients, as shown below. When a call comes in, the program captures
the caller id and looks it up in the address book. If a match found, the program takes the actions
based on the setup you entered in the contact entry. For example, the caller illustrated below is auto-
recorded, and email notified.



To create a contact in the address book, you first switch to the Contact Address Book panel by
clicking the Contact tab under the folder tree window. Then, select one of the folders under the
address book on the left panel, and next add a new contact by:

Selecting the File menu on EzPhone Recorder menubar and choose the New submenu item.
Right-clicking on the right listview panel to bring up the shortcut menu, and then choose the New
menu item.

The contact dialog is now displayed, and you can enter your contact details and select recording and
notification options on the dialog.

NOTE: This feature requires you to subscribe to caller id service from your telephone company.
Besides, if a voice modem is used to record phone calls, it must support caller id detection in your
country. If a phone recording adapter is used, it usually can detect the caller id correctly unless your
phone line is noisy with poor sound quality. To resolve the issue for noisy phone lines, please refer
details to why the caller id is not displayed or captured correctly.
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4.4 Listen to recorded messages.
To listen to a recorded message, please select it first, and then you can do one of the followings:

Click the Play (>) button at the bottom of the right list view window to listen to the recorded
message instantly.
Select the File menu on the EzPhone Recorder menubar and choose the Open submenu item.
Double click the message itself to bring the message information dialog.
Click the Open button on the EzPhone Recorder toolbar.

For the last three methods, the message information dialog is displayed. You can click the Play
(>) button at the bottom of the dialog window to start playback.
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4.5 Attach notes to recorded messages or contacts.
To attach notes or memos to recorded messages or contacts in the address book, you can:

Double-click the item.
Select the item and click the Open button on the EzPhone Recorder toolbar.
Select the item, go to the File menu on EzPhone Recorder menubar, and choose the Open
submenu item.

A dialog window is now displayed, which contains the message or contact details. You can enter your
notes into the notes field on this dialog.
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4.6 Find recorded messages or contacts.
To find recorded messages or contacts, you can select the Tools menu on EzPhone Recorder menubar
and choose the Find submenu item. You can also click the Find button on the EzPhone Recorder
toolbar. The find dialog is then be displayed, and you can now specify your find options on this dialog
window.
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4.7 Sort recorded messages or contacts.
To sort recorded messages or contacts, you can click on the corresponding column header of the list
view on the right panel. Alternatively, you can go to the View menu on the EzPhone Recorder
menubar, choose the Sort Messages By submenu item, and then select the fields that you want to
sort.
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4.8 Delete recorded messages or contacts.
To delete recorded messages or contacts, you first select them and then click the Delete button on
the EzPhone Recorder toolbar. Alternatively, you can click the Edit menu and choose the Delete
submenu item. The deleted items are sent to the Deleted Folder. They can be automatically emptied
upon exit if you turn on the option Empty Deleted Messages Folder on Exit on Setup Preferences
dialog, as shown below.
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4.9 Move/Copy recorded messages or contacts.
To move or copy recorded messages or contacts, you first select them. Then, you click the Move
button on the toolbar, or go to the Edit menu on EzPhone Recorder menubar, choose the Move or
Copy submenu item.

To move items, you can also drag your selected items and drop them to the target folder.
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4.10 Create a new folder.



To create a new folder, go to the File menu on EzPhone Recorder menubar, choose the Folder
submenu item and click on the New menu item. You can also use the shortcut menu by right-clicking
on the folder tree window on the left panel.

NOTE: The folder created is under your currently selected folder. Create a folder under the Deleted
Messages folder is not allowed.
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4.11 Rename a folder.
To rename a folder, please select it first by clicking on it. Then, go to the File menu on the program
menubar, choose the Folder submenu item and select the Rename item. You can also use the
shortcut menu by right-clicking on the folder tree window on the left panel.

NOTE: The system created folders (Root folder, Inbox, Junk Calls, and Deleted Messages) are not
allowed to be renamed.
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4.12 Delete a folder.
To delete a folder, please select it first by clicking on it. Then, go to the File menu on the program
menubar, choose the Folder submenu item and click on the Delete item. You can also use the
shortcut menu by right-clicking on the folder tree window on the left panel.

NOTE:

The system created folders (Root folder, Inbox, Junk Calls, and Deleted Messages) are not
allowed to be deleted.
Non-empty folders can not be deleted unless the messages contained in these folders are
removed first.

Back to top

4.13 Hide/Show the toolbar or folder tree.
To hide or show the toolbar or folder tree, go to the View menu on the program menubar. Then,
choose the Toolbar or Folder Tree menu item. The ticks beside these menu items indicate whether
the toolbar or folder tree is shown. Selecting these menu items again hides the toolbar or folder tree,
and also remove ticks from the menu items.
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4.14 Save the recorded message to other media or locations.
The recorded message can be saved to other locations or media such as a USB drive and is saved as a
wave audio file. To save a recorded message, please select it first. Then, go to the File menu on the
program menubar, and choose the Save As submenu item. You can also use the shortcut menu by
right-clicking on the list view window on the right panel.

NOTE: Only one recorded message can be saved at a time.
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4.15 Read the user manual.
To read the user manual, go to the Help menu on the program menubar and choose the User Manual
submenu item. You can also click the Manual button on the program toolbar.
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5.1 What is an EzPhone Recorder user id?
The user id is a 10-character long string containing digits or letters. To find out your user id, you can
click the Purchase button on the EzPhone Recorder toolbar, or go to the Help menu, and choose the
Register & Purchase sub-menu item. The user id is then displayed on the top left corner of the
Registration popup dialog shown below.

 

This string is unique on a per-computer basis and is automatically generated by EzPhone Recorder
after you install and run the program. The software uses this id to verify against your license key. If
the license key can be verified, EzPhone Recorder never expires, and hence you can keep the software
permanently.
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5.2 How do I obtain the EzPhone Recorder license key?
To obtain your license key, please have your EzPhone Recorder user id ready and click the link
below after you log on to the internet. If you are a registered user and have already purchased
EzPhone Recorder, you are emailed with the license key within a few minutes upon submission of the
request form below.

Request EzPhone Recorder License Key. (free for paid users only)

Upon receiving the license key, please click the Purchase button on your EzPhone Recorder toolbar to
bring up the Registration dialog window, and copy and paste the license key to the popup window.
Click the OK button on the popup to save the license key. EzPhone Recorder now runs on your
machine permanently without any nagging screens.
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5.3 What is a telephone recording adapter, and what are the
recommended ones?
A phone recording adapter usually has one end connecting to your phone line or handset, and the
other end plugging into your PC microphone jack or USB port. It is a passive telephone line monitoring
device. Hence, it does not impact your incoming or outgoing calls, and both the caller and called party
can not even sense the existence of this device. As such, a phone recording adapter can not play a
legal announcement before the phone recording. EzPhone Recorder should work all types of
telephone recording adapters that are designed for use with your PC microphone jack or USB port.

NOTE:

Because phone recording adapters generally can not play a legal announcement. Therefore, it is
your responsibility to ensure that your recording activities comply with your local or country
regulations and laws.
Please ensure your phone recording adapter is connected to the computer before you start
EzPhone Recorder.
If you are using Windows 10, please ensure the microphone access permission is granted to
applications. You can do this by going to the Windows Settings settings panel, select the
Privacy panel, and choose the Microphone on the left panel to bring up the Microphone setup

https://ezphonerecorder.sunshinesoftsolutions.com/register/reqkey.htm
ms-settings:privacy-microphone


page. On the page, please turn on options: Allow access to the microphone on this device
and Allow apps to access your microphone.

To learn more about recommended telephone recording adapters, please log on to the internet and
check the FAQs page on the EzPhone Recorder web site for further details.

Back to top

5.4 What is a voice modem, and what are the supported voice modems?
A voice modem is also a regular dialup modem that supports voice in addition to its data/fax
capabilities. It usually has one end connecting to your phone line, and the other end plugging into a
USB port on your computer. When you purchase a modem, please make sure that it supports voice
and phone answering machine feature. EzPhone Recorder works with all voice-enabled modems.

NOTE:

Your cable or DSL modem is not a voice modem. A cable or DSL modem can NOT be used for
phone recording purposes.
Drivers are usually required for voice modems. Please install the modem driver from the CD/DVD
that comes with the modem retail package before plugging it to your computer USB port.

To learn more about recommended voice modems, please log on to the internet and check the FAQs
page on the EzPhone Recorder web site for further details.
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5.5 Can I use EzPhone Recorder to record phone calls from a mobile
phone?
YES. EzPhone Recorder can record all your mobile phone conversations by using a mobile/cellular
phone recording adapter connected to the computer, as illustrated below. In the diagram, the mobile
phone recording adapter has a sound pickup opening at the back of the earpiece. To record phone
conversations, you move the speaker on the mobile phone to cover this opening. Please also plug the
other end of the adapter to the microphone jack on your computer shown below.

NOTE: When a mobile phone recording adapter is used for recording call communications, you have to
record each incoming and outgoing call manually. Besides, due to the limitations of the adapter, the
legal announcement can not be played. Therefore, it is your responsibility to ensure that you comply
with your local, state/province, or country laws when recording phone conversations.

https://ezphonerecorder.sunshinesoftsolutions.com/pages/faqs.htm
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If you notice the call is not recorded correctly, for example, it got cut off very often, and you can
adjust the silence sensitivity for it. To do this, please go to the Setup menu on EzPhone Recorder
menubar and select the Phone Recording Lines & Devices submenu item. Then, The Setup Phone
Recording Devices & Lines dialog is now displayed. Next, click the Setup button beside the
dropdown list for this recording line to bring up the Setup Recording Mode window. You can now
change recording volume and gains under the Recording Mode section, along with the silence
detection parameters under the End of Recording section. You can also find the dialog screenshot in
this manual under the section: Configure Call Recording Parameters. Once completed, click the
OK button to save all settings.

There are quite a few inexpensive adapters available to accomplish this task, and the sound quality is
pretty decent too. To learn more about recommended mobile phone recording adapters, please log on
to the internet and visit the FAQs page on the EzPhone Recorder web site for further details.
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5.6 Why doesn't EzPhone Recorder record my phone calls correctly?
There can be many reasons for the above question. Below lists a few common causes and their
solutions.

Please ensure that EzPhone Recorder is not installed under a limited user account, so the
program has both read and write access permissions to its directory.
Please also be aware that the Windows Update service automatically updates your driver from
time to time. In some instances, this may cause problems. If this ever happens, please reinstall
the original driver that comes with your device.
If you successfully used EzPhone Recorder in the past, but it now stops working after upgrade to a
newer version of Windows. You can try to update your device driver with the original one that
comes with your device. It this is still not working, please contact the device manufacturer to
download and install the latest driver.

For specific device issues, please follow the checklist below:

If you are using a phone recording adapter,
Please ensure that the adapter you have purchased is for PC use, not for the traditional tape
recorder. In other words, it is supposed to connect to a computer microphone jack or USB
port, not to a conventional tape recorder.
If you are using Windows 10, please ensure the microphone access permission is granted to
installed applications. You can do this by going to the Windows Settings, select the Privacy
panel, and choose the Microphone on the left panel to bring up the Microphone Settings

https://ezphonerecorder.sunshinesoftsolutions.com/pages/faqs.htm
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page. On that page, please turn on options: Allow access to the microphone on this
device and Allow apps to access your microphone.
If the adapter is connecting to your USB port, please ensure its driver is installed correctly.
You can verify this by running the Windows built-in Voice Recorder app. If the Voice
Recorder app reports errors, it indicates the driver is not installed properly. Please reinstall it
or contact the vendor to find more solutions.
If the phone recording adapter does not report the caller id correctly, please refer to the
question: why caller id is not captured or displayed.

If you are using a voice modem,
Please make sure that your modem is a voice modem. You can find this information by
selecting the Phone Recording Lines & Devices submenu item under the Setup menu on
EzPhone Recorder main window.
Please also ensure that the telephone line is connected directly onto the modem jack marked
Line. Besides, make sure no other devices are plugged to the modem jack marked Phone.
Because if this jack is plugged with a telephone device, some modems may have problems in
recording phone calls.
Occasionally, EzPhone Recorder reports that your modem is not a voice modem, but the
device specification clearly states its telephone answering machine capability. In such a case,
this typically indicates the improper installation of the modem driver. Please reinstall the
original driver that comes with your modem. If the driver reinstallation does not resolve the
problem, please visit the modem manufacturer's web site to download the latest modem
driver.
If your modem can not record voice messages longer than 60 to 90 seconds, please refer to
the question: why phone calls can be recorded for only a few seconds.
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5.7 Is EzPhone Recorder a PC-based phone answering machine?
EzPhone Recorder is NOT a PC-based phone answering machine. However, it is compatible with most
answering machine software. If you are interested in using answering machine software along with
EzPhone Recorder. We would highly recommend you to use EzVoice. It supports caller ID, ten voice
mailboxes, customized greetings, and a lot more. Ideal for small business use. You can find out more
details about EzVoice at the following link:

https://ezvoice.sunshinesoftsolutions.com
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5.8 Does the computer need to be on all the time?
YES. EzPhone Recorder is software, and its machine codes need to be executed by the computer.
Without computer running, EzPhone Recorder is not even loaded into the memory. Therefore, it cannot
record phone calls for you if the computer is off.
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5.9 I do not have a fiber, cable, or DSL connection. Can I still use EzPhone
Recorder?
YES. You can use EzPhone Recorder to record your phone calls because this program does not require
you to have a fiber, cable, or DSL connection.

EzPhone Recorder uses a phone recording adapter or voice modem to record your phone calls. You
should be able to use most of the functions, such as recording incoming and outgoing calls without any
problem. However, without an always-on internet connection provided by fiber, cable, or DSL service,
you can NOT be notified of newly recorded calls through email.
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5.10 My telephone service is provided by a VoIP, fiber, cable, or DSL
company. Can I use EzPhone Recorder?
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YES, you can use EzPhone Recorder to record your phone calls.

If you subscribe to VoIP service, the VoIP company should provide you with a conventional telephone
jack from its VoIP adapter. So you can plug in your regular desk telephone to it. Similarly, if your
telephone connection is provided by a fiber, cable, or DSL company, you usually have a regular
telephone jack from its router or DSL microfilter.

To let EzPhone Recorder record phone calls, you use a phone recording adapter or voice modem.
You connect one end of it to your telephone line jack and the other end to the computer microphone
jack or USB port.

NOTE: If you are using a handset-based phone recording adapter, you need to plug the device with
one end to the computer and the other end to the phone handset.

EzPhone Recorder utilizes your phone recording adapter or voice modem to record telephone calls for
you. Therefore, it has a minimum impact on any of your existing communication connections.
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5.11 Does EzPhone Recorder work on Windows 10/8.1/8/7/Vista/XP?
YES. EzPhone Recorder works on all Windows platforms such as Windows 10/8.1/8/7/Vista/XP. If you
encounter problems after upgrading to a newer version OS, please reinstall the driver for your phone
recording adapter or voice modem that initially comes with your device. If the problem persists, please
visit your modem manufacturer website to download and install their latest modem driver for the new
OS.
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5.12 Why isn't the caller id displayed or captured correctly?
The caller id is a service from your telephone service provider, and you need to subscribe to this
service to be able to see the caller's name and phone number. Please verify this with your telephone
service provider.

The caller id is typically delivered to the called party between the first and second rings. Therefore, if
someone answers the call before the second ring, EzPhone Recorder is not able to capture the caller
id. In such a case, this is not a problem. You can stop picking up the phone before the second ring so
the caller id can be captured appropriately.

For specific device issues, please follow the checklist below:

If you are using a phone recording adapter,
You do not see any caller id is captured, and this could be caused by low signal energy.
Please check whether there is a volume control tuner on the phone recording adapter. If it
does, please turn the tuner on the device to increase the volume so the caller id signals can
be detected successfully.
The caller id is detected, but it does not seem to be correct for each digit. That could be
caused by noisy or high signal energy. Some recording devices provide a sound boost that
can cause such issues. If this is the case, please go to the Sound Control panel and click the
Recording tab on the window. Then, select the recording device that you have a problem
with and right-click on it to bring up the Microphone Properties dialog, as shown below.
Please click on the Levels tab to bring up the Microphone volume setting dialog. Next,
you can move the Microphone Boost slider to the far left, or enter value 0 to disable the
microphone boost altogether as follows.



To correctly capture a caller id, you should also disable other sound effects that might
interfere with the caller id detection. To do this, please go to the Sound Control panel and
click the Recording tab on the window. Then, select the recording device that you have
trouble with and right-click on it to bring up the Microphone Properties dialog, as shown
below. Choose the Enhancements tab on the dialog, next un-check the option Disable all
sound effects and click the OK button at the bottom of the dialog window to save all your
changes. The reason for the above is that if the Noise Suppression or Acoustic Echo
Cancellation are enabled, these sound effects are applied to all recorded audio data,
including the caller id. Hence, the initial caller id data sent by your telephone company are all
changed and corrupted.

If you are using a voice modem,
The caller id can be obtained only if your modem hardware is capable of doing so. If you are
unsure about your modem features, please check with your modem manufacturer for further
details.
Different countries have different standards and systems to transfer caller id to the called
party. Thus, when you install the modem driver for the first time, please make sure that you
select the country correctly.
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5.13 Why doesn't EzPhone Recorder record or play a legal announcement
correctly?
To successfully record or play a legal announcement through the EzPhone Recorder build-in recorder,
please make sure you have attached a microphone or speaker to your computer correctly.
Furthermore, ensure that you select the right recording or playing device that is connected to the
computer.

To record a legal announcement, you go to the Setup menu and choose the Legal Announcement
submenu item. The Setup Sound Devices & Legal Announcement window is now displayed, which
contains a dropdown list of all sound devices on your computer. Please select the correct playing and
recording devices from the dropdown list and proceed to the Legal Announcement section on the



dialog. Turn on the legal announcement option and click the Record (O) button on the window to
record your announcement. When you finish, click the Stop button and follow by the OK button to
save all your settings.

The option of Auto-enhance sound quality when recording a legal announcement is provided to
suppress the noise, boost the recording gain, and automatically optimize the sound quality for the
legal announcement. However, if the recorded legal announcement is unclear or distorted, you can
disable this option under the Recording Device section on Setup Sound Devices & Legal
Announcement dialog.

Additionally, if you record only silence for your legal announcement, please do the following.

Check whether there is a volume control tuner on the microphone, if it has one, please turn the
tuner to increase the volume.
Move your mouth closer to the microphone, and re-record it to see whether the problem resolves.

NOTE: When a phone recording adapter is used to record phone calls, the legal announcement is not
played because the adapter lacks sound playback capability. Therefore, it is your responsibility to
ensure that your recording activities comply with your local or country regulations and laws.
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5.14 How can I import a pre-recorded legal announcement to EzPhone
Recorder?
In most cases, it is recommended to use EzPhone Recorder built-in recorder to record your legal
announcement as this built-in recorder automatically optimizes the audio quality. However, if you
already have a professionally recorded announcement and would like to import it, you can follow the
instructions below.

To import a pre-recorded announcement, please ensure that the audio file is a standard wave file in
the PCM format with 16 bits per sample at the sampling rate of 8000Hz in a mono channel. If
your wave file is not in this format, you can use Microsoft Sound Recorder to convert this file to the
above form. Then, you can copy this file to your EzPhone Recorder installation directory to overwrite
the legal announcement file, which is LegalAnncmt.wav.

Back to top

5.15 Why does the recording of a call stop after a few seconds?
5.16 Why are the call messages recorded for only a few seconds?
If you are using a voice modem with Agere or Lucent based modem chip, your phone call recording is
usually cut off abruptly around 60 to 90 seconds after the start. That is a known issue in Lucent
modem driver that automatically stops recording after its preset timer expires. Fortunately, EzPhone
Recorder is fully aware of this issue and already provides a built-in patch that can completely fix the
problem. Please refer to the use of the built-in FAQs and troubleshooting to resolve common
issues.

If you do not use the above modem, and still encounter the problems, this typically indicates the
inappropriate settings of timeout value for hang-up or silence sensitivity as explained below.

EzPhone Recorder can stop recording if the timeout value for the call recording is reached.
Therefore, if you use and specify this timeout value, it is recommended to input a reasonable
value that is not too small. So the entire call conversations can be recorded.
Additionally, EzPhone Recorder also stops the call recording upon the successful detection of the
silence. If you enter a large silence sensitive threshold, the program is then less sensitive in
detecting silence. In that case, even if the call is still going on and voice energy is loud enough,
the program still considers them as silence and hence stops the call recording. Therefore, it is
recommended not to provide a large value for the silence sensitive threshold.

To update these settings, you can go to the Setup menu and choose the Phone Recording Lines &
Devices submenu item. The Setup Phone Recording Devices & Lines dialog is displayed, click the
Setup button beside the dropdown list for the recording line to bring up the Setup Recording Mode
window. You can now proceed to the End of Recording section on the dialog window. Once there, you
can increase the length of a recording, and move the silence sensitivity slider to the left to
decrease the silence sensitivity threshold. Once it is done, click the OK button to save all settings.



NOTE: If you specify a small silence sensitivity threshold for the line using a phone recording adapter,
this may cause the false detection of noises as voice calls. In turn, the erroneous detection triggers
the auto-recording, and as a result, produces many small recorded messages in your inbox. If email
notification is activated, you may receive many emails that only contain empty recorded messages.
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5.17 Why doesn't email forwarding work successfully?
5.18 Why doesn't Google/Gmail or Yahoo send email notification
correctly?
To be notified of newly recorded calls through email, you must have an always-on internet connection
such as fiber, cable, or DSL to the computer where EzPhone Recorder runs on. Then, you set up the
email server and login details in the program. Once that is done, please also ensure that your email
spam filter does not identify notification emails as junk mails.

For Google/Gmail or Yahoo email, they both disable the direct email client access by default, and you
must turn that on to be able to receive email notifications. To activate this, you first sign in to your
account and go to your Google or Yahoo account info settings and choose the Account Security
tab. Then, you find the option Allow less secure apps or Allow apps that use the less secure
sign in. Once turned on, the program can now connect to the email server and notify you of the
recorded calls to your email.

To confirm all your settings, please test them by clicking the Send a Test Email button on the Setup
Email Notification and Forwarding dialog window in EzPhone Recorder. If you can successfully
receive the test email, you are all set.
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5.19 Does EzPhone Recorder work outside the US and Canada?
Yes, EzPhone Recorder is designed to comply with international telephone standards (ITU) and is
thoroughly tested under various environments. To find out whether it works for you, you can download
a FREE trial at the following link. You make a purchase only when it suits your needs.

https://ezphonerecorder.sunshinesoftsolutions.com

Thank you for your interest in EzPhone Recorder.
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5.20 How do I remove EzPhone Recorder?
To thoroughly remove EzPhone Recorder from your computer, please go to the Control Panel and
select the Programs and Features or Add/Remove Programs panel. The program list window
pops up, choose EzPhone Recorder from the list and click the Add/Remove button. Then, the setup
wizard automatically uninstalls the program from your system.

During the uninstallation, you are also asked whether you want to remove your recorded messages
from the disk. They are only removed if you choose so. Otherwise, a back up of all recorded messages
is created and usually stored under the My Documents folder by default. If you change your mind
after the uninstallation, you go to the directory and manually delete them.
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